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Precision Detectors, Inc.  
Warranty  and Electronic End User License Agreement  

 

NOTICE TO USER: THIS IS A CONTRACT. BY INDICATING YOUR ACCEPTANCE DURING 
INSTALLATION, YOU WILL BE ASKED TO ACCEPT ALL THE TERMS AND CONDITIONS OF 
THIS AGREEMENT. 

This Precision Detectors, Inc. (PDI�• ) End User License Agreement accompanies a Precision Detectors 
software product and related explanatory materials. The term "Software" shall include all software 
packages delivered to you by PDI and any upgrades, modified versions or updates of the Software 
licensed to you by PDI. This copy of the Software is licensed to you as the end user for use by you and 
other users of a specific PDI hardware System purchased, leased or rented by you. 

Please read this Agreement carefully. 

PDI grants to you a non-exclusive license to use the Software, provided that you agree to the following: 

1. Use of the Software.  

a) You may install the Software in a single location on a hard disk or other storage device; 
install and use the Software on a file server for local execution over your network (but not for 
the purpose of copying onto a local disk or other storage device); for use only with the 
specific system; 

b) You may make backup copies of the Software; 

c) You may transfer the Software from one computer to another over your network, or relocate 
the Software on your site, but you may not copy it to additional sites over the network or 
make additional copies for use on additional networks or sites for use with other hardware; 

d) You may copy the Software to the personal computer of Users and such Users may use the 
software to examine, recompute and print out files collected in conjunction with the System; 

e) You may obtain additional electronic copies of the Software directly from PDI for the cost of 
media, handling and shipping. 

2. Copyright.  

The Software is owned by PDI and its suppliers, and its structure, organization and code are valuable 
trade secrets of PDI and its suppliers. The Software is also protected by United States Copyright Law 
and International Treaty provisions. You agree not to modify, adapt, translate, reverse engineer, 
decompile, disassemble or otherwise attempt to discover the source code of the Software. You may 
use trademarks only to identify printed output produced by the Software, in accordance with accepted 
trademark practice, including identification of trademark owner's name. Such use of any trademark 
does not give you any rights of ownership in that trademark. Except as stated above, this Agreement 
does not grant you any intellectual property rights in the Software. 
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3. Transfer.  

You may not rent, lease, or sublicense the Software. You may, however, transfer all your rights to use 
the Software to another person or entity, provided that you transfer this Agreement with the Software. 

4. Warranty.  

The Software delivered to you is PDI's current standard version and performs as described in PDI's 
brochures. For a period of one year from the date of delivery, PDI agrees to correct defects that the 
user identifies as not performing as described in PDI's brochures. PDI DOES NOT AND CANNOT 
WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE 
SOFTWARE OR DOCUMENTATION. PDI MAKES NO WARRANTIES, EXPRESS OR 
IMPLIED, AS TO MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. IN 
NO EVENT WILL PDI BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR 
SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN IF A PDI 
REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR 
FOR ANY CLAIM BY ANY THIRD PARTY. Some states or jurisdictions do not allow the 
exclusion or limitation of incidental, consequential or special damages, or the exclusion of implied 
warranties or limitations on how long an implied warranty may last, so the above limitations may not 
apply to you. 

5. Governing Law and General Provisions. 

This Agreement will be governed by the laws of the State of Massachusetts, United States of 
America, excluding the application of its conflicts of law rules. This Agreement will not be governed 
by the United Nations Convention on Contracts for the International Sale of Goods, the application of 
which is expressly excluded. If any part of this Agreement is found void and unenforceable, it will not 
affect the validity of the balance of the Agreement, which shall remain valid and enforceable 
according to its terms. You agree that the Software will not be shipped, transferred or exported into 
any country or used in any manner prohibited by the United States Export Administration Act or any 
other export laws, restrictions or regulations. This Agreement shall automatically terminate upon 
failure by you to comply with its terms. This Agreement may only be modified in writing signed by 
the President of PDI. 

6. Notice to Government End Users.  

If this product is acquired under the terms of; 

(i) a GSA contract - Use, reproduction or disclosure is subject to the restrictions set forth in the 
applicable ADP Schedule contract; 

(ii)  a DOD contract - Use, duplication or disclosure by the Government is subject to restrictions 
as set forth in subparagraph (c) (1) (ii) of 252.227-7013; 

(iii)  a Civilian agency contract - Use, reproduction, or disclosure is subject to 52. 227-19 (a) 
through (d) and restrictions set forth in the accompanying end user agreement. 

7. Only Terms and Conditions.  

These Terms and Conditions are the only terms and conditions related to the use of this software; they 
supercede any previous agreement with respect to the software, and may only be altered in a written 
agreement signed by PDI and you. 

Unpublished rights reserved under the copyright laws of the United States. Precision Detectors, Inc., 34 
Williams Way, Bellingham MA 02019. 

Your acceptance or decline of the foregoing Agreement [was or will be] indicated during installation. 
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Chapter 1  

Introduction  

 

1.1  OVERVIEW  

This manual describes PrecisionAcquire - USB, which is designed to provide for collection of data from a 
wide variety of light scattering instrumentation manufactured by Precision Detectors, Inc. A detailed 
discussion on static light scattering is presented in Appendix A and a detailed discussion on dynamic light 
scattering is presented in Appendix B. 

1.2  INSTALLATION  

To load the software onto the personal computer: 

a) Place the distribution diskette in the CD-ROM drive. If your computer is configured for Autorun, a 
Welcome screen will be presented (if your computer is not configured for Autorun, select Setup.exe on 
the CD to access the Welcome screen). 

b) The Install program presents a series of dialog boxes that are self-explanatory. When you access the 
dialog box that presents the programs to load, select PrecisionAcquireUSB. The password that is 
provided with the system will allow you to load the program. 

1. 3  GENERAL CONVENTIONS  USED IN THIS MANUAL  

This program is a Windows�“  application that follows general Windows conventions. All windows, dialog 
boxes, controls, short cut keys, scroll bars, etc. operate according to standard Windows procedures. For 
the sake of brevity, we use the following conventions: 

�x�� It is understood that the OK button is to be clicked (or the ENTER key on the keyboard is to be 
pressed) to accept the settings and close a dialog box. 

�x�� It is understood that the CANCEL  button is to be clicked (or the ESC key on the keyboard is to 
be pressed) to close a dialog box and preserve the original settings. 

�x�� The APPLY button is to be clicked to change settings without closing the dialog box. 

�x�� Common dialog boxes and commands that are similar to other Windows programs are not 
described (e.g. the Open dialog box, is identical to that used in programs such as Word). 

When we are describing a dialog box or window, the name of the window will appear in italics: 

Access the Setup Detectors �G�L�D�O�R�J���E�R�[���« 

When a button (or a command from a menu), is to be chosen, the button (command) is shown in italics: 

 To initiate data collection, click Start on the menu bar. 

On-line help is available by pointing to the field of interest and pressing F1. 

     1  
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1. 4  THE WELCOME DIALOG B OX  

When the program is initially open, the Welcome dialog box (Figure 1-1), which is used to select the 
appropriate electronics module is presented. The drop down menu lists each of the electronics modules 
that can be employed. 

 

Figure 1-1:  The Welcome Screen 

The format of the Welcome dialog will depend on the electronics module that is selected. (e.g. if you 
select the PD4045 Electronics Module, the check box and legend for the PD4044 Remote I/O Module 
will not be presented). 

The items below the legend Check below to disable the drivers for are provided for diagnostic purposes 
and should not be checked for normal operation. 

The Remember Setup check box is used to indicate that the Welcome screen should be suppressed in 
normal operation. If this box is presented, the Main Window (Chapter 2) will be presented when the 
system is powered up. Once you have indicated the appropriate electronics module, this selection should 
be made as it is probable that you will be using the same electronics module.  

Note: The View menu (Section 2.2.2) includes a command to present the Welcome dialog box when the 
software is powered up if it becomes necessary to change the electronics module selection. 
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1.5  FOR ADDITIONAL INFORMATION  

�7�K�L�V���P�D�Q�X�D�O���V�K�R�X�O�G���E�H���X�V�H�G���L�Q���F�R�Q�M�X�Q�F�W�L�R�Q���Z�L�W�K���W�K�H���R�S�H�U�D�W�R�U�¶�V���P�D�Q�X�D�O���I�R�U���W�K�H���L�Q�V�W�U�X�P�H�Q�W�D�W�L�R�Q���W�K�D�W���W�K�H��
software is used with. For additional information, please contact: 

Precision Detectors, Inc. 
34 Williams Way 
Bellingham, MA 02019 USA 
(508) 966-3847 

Or your nearest PDI representative. 
     1  
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Chapter 2  

The Main Window  

 

2.1  THE MAIN WINDOW  

The Main window (Figure 2-1) consists of a menu bar which contains a variety of commands, a tool bar 
which contains a series of short cuts, a data pane and a status bar. 

 

Figure 2-1:  The Main Window 

The format of the main screen and the activities provided by the program is dependent on the system that 
is selected in Figure 1-1. This discussion is based on the configuration for the Model PD4043 electronics 
module. 

     2  
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2.2  THE MENU BAR  

2.2.1  The File Menu  

The File menu includes the following commands: 

�x�� Open - accesses a standard Windows dialog box to select a data file to be viewed 

�x�� Exit  - closes the program. If the program is closed while data is being collected, data acquisition 
will automatically cease and data which has been collected will be saved. 

2.2.2  The View Menu  

The View menu includes the following commands: 

�x�� Absolute Scale - the intensity for each detector is presented using its own scale (in mV). 

�x�� Relative Scale - the presentation of the intensity for each trace is set full scale between 0 and 1 V, 
basically normalizing each detector)relative to the reference detector for the left Y-axis or the 
right Y-axis as indicated on the Detector Display dialog box (Section 2.3.xx) 

�x�� Graph Colors - presents a sub-menu to select the item for which the color is to be changed. 
There are three options, Background, Graph and Labels. When the desired option is selected, a 
standard windows color dialog box is selected and the user can select the desired color for that 
element. 

2.2.3  The Acquire Menu  

The Acquire menu includes the following commands:  

�x�� Single Run - used to access the dialog box used to present the parameters and initiate a single 
run. 

�x�� Multiple Run  - used to access the dialog box used to present the parameters and initiate a 
multiple run. 

�x�� Zimm Plot - used to access the dialog box used to present the parameters and initiate data 
collection for a Zimm plot.  

The Stop Run command is employed to terminate data collection. When a run is terminated, all data that 
has been collected will be saved with the appropriate file name. 

The Run dialog boxes are described in detail in Chapter 3. 

2.2.4  The Setup Menu  

The Setup menu includes the following commands: 

�x�� Detectors - presents the Setup Detectors dialog box, which is used to select the detectors that are 
to be monitored. The format of this dialog box is dependent on the system and is described in 
Section 2.3. 

�x�� Detector Display - used to select the general format of the depiction of each detector trace (line 
type and symbol) and indicate what the left Y-axis and right Y-axis should denote (Section 2.4). 

�x�� System Configuration - presents a dialog box to select a number of system parameters. This 
dialog box is described in Section 2.4. 
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2.2.5  The Monitor Menu  

The Monitor menu contains the following command: 

�x�� Monitor  - presents a window (Figure 2-2) which monitors the photon count (DLS systems only). 
The decimal radio button presents the data in decimal format. 

 

Figure 2-2:  Monitor Photon Count Window 

2.2.6  The Help Menu  

The Help menu includes the following commands: 

�x�� Help - accesses the on-line Help file  

�x�� Version - presents a dialog box that indicates the version number of the program. Please refer to 
this number when contacting Precision Detectors for assistance.  

2.3  BUTT ONS  

The buttons immediately below the menu bar provide the following functions: 

 - Equivalent to the Open command on the File menu 

 - Equivalent to the Close command on the File menu 

 - Equivalent to the Print command on the File menu 

 - Equivalent to the Single Run command on the Acquire menu 

 - Equivalent to the Multiple Run command on the Acquire menu 

 - Equivalent to the Zimm Run command on the Acquire menu 

 - Stops the present run. 

 - Powers up/turns off the laser. 

The buttons that are active is dependent on the present status of the system. If the system is collecting 
data, the S, M and Z buttons will not be active. If the system is not collecting data, the Stop button will 
not be active. 

     2  
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2.4  THE STATUS BA R 

The status bar at the bottom on the window presents the following information: 

�x�� Instrument Status 

�x�� Number of Photons 

�x�� Run Time 

�x�� Temperature  

2. 5  DETECTOR DISPLAY  

Two commands on the Setup menu are used to define the detector display, Detectors and Detector 
Display.  

2. 5 .1  Setup Detectors  

The format of the Setup Detectors dialog box is dependent on the nature of the system, which is indicated 
on the System Configuration dialog box. 

2. 5 .1.1  PD2000  

The Setup Detectors dialog box for the PD2000 is presented in Figure 2-3. Up to eight detectors can be 
used with the PD2000 system. To indicate that a detector should be employed, place a check mark to the 
left of the appropriate channel. For channels 1-6, the color of the trace and the detector type is fixed, for 
channels 7 and 8, the user can define the channel via the drop down menu.  To select the color, click in 
the square to the right of the channel legend to present the Windows Color dialog box. 

 

Figure 2-3:  Setup Detectors Dialog Box - PD2000 System 
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2. 5 .1.2  PDExpert System  

The Setup Detectors dialog box for the PDExpert system is presented in Figure 2-4. To indicate that a 
detector should be employed, place a check mark to the left of the appropriate channel and indicate the 
detector type from the drop down menu. To select the color for each channel, click in the square to the 
right of the channel legend to present the Windows Color dialog box. 

 

Figure 2-4:  Setup Detectors Dialog Box �± PD Expert System 

2. 5 .2  Detector Di splay  

The Detector Display dialog box (Figure 2-5) is used to indicate the format of the trace for each channel 
and to indicate the formal definition of the left and Right Y-axes. 

     2  
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Figure 2-5:  Detector Display Dialog Box 

To select the line format for a detector, click on the rectangular box to the right of the channel to present a 
list of the available formats (Figure 2-6) and click on the desired line type. If more than eight detectors 
have been selected, the Detector Display dialog box will include sufficient lines to select the format for 
each detector 

 

Figure 2-6:  Linetypes Dialog Box 
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To select the format of each data point, click on the square adjacent to the line types to present a display 
of the available symbols (Figure 2-7). 

 

Figure 2-7:  Symbols Dialog Box 

The Left Y-Axis and Right Y-Axis radio buttons are used to indicate which axis should be the reference 
axis for that detector. The Left-Y-Axis Label and Right Y-Axis Label field drop down menus are used to 
indicate which detector labels should be used as the reference for the axes. 

2. 5 .3  System Control  

The System Control dialog box (Figure 2-8) is used to set a series of instrument parameters. To 
turn the Laser, Alignment Laser or Temperature Control (Expert only) on (off), press the 
appropriate button in the System Status field.  

 

Figure 2-8: System Control Dialog Box  

To change the Laser Power or the Cell Temperature, enter the desired value in the field and press Set. 
These values can be overridden in the Run dialog box as described in Chapter 3. 
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2. 6  SYSTEM CONFIGURATION  DIALOG BOX  

The System Configuration dialog box (Figure 2-9) is used to indicate a number of instrumental 
parameters: 

 

Figure 2-9:  System Configuration Dialog Box 

Select the system that is being used to collect the data by choosing the appropriate radio button. If you are 
using the Expert system, the PD4044 Remote I/O Module Present option will be presented. 

The Collection Fraction field is used to indicate the fraction of the data that will actually be used. This 
feature is used to minimize shot or random noise, as an example, if 0.50 is selected; the lowest 50% of the 
data that is collected will be used. For typical aqueous applications, a value of 0.10 is used, since the 
particles are large and for typical applications using organic solvents (e.g. THF) 0.75 is recommended. 
The remaining data will be discarded.   

The Sample Rate should be selected from the drop down menu. In areas where the line frequency is 60 
Hz, the Sample Rate should be set to 100 Hz, in areas where the line frequency is 50 Hz, the Sample Rate 
should be set to 90 Hz. 

The wavelength of the laser that is employed in the system should be entered. 
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2. 7  TEMPERATURE CALIBRAT ION  

If the PDExpert system is employed, the temperature calibration feature can be established via the 
Temperature Calibration dialog box (Figure 2-10). Enter the desired temperature range and the step in the 
upper left corner. If an equilibration time is desired between the time the temperature is reached and the 
data is to be collected, complete the upper right fields. 

 

Figure 2-10:  Temperature Calibration Dialog Box 

The Current Status fields are used to indicate the present settings during a run. 

Note: This feature is provided for service and diagnostic functions and the user does not need to calibrate 
the system on a routine basis. It is recommended that you contact Precision Detectors before attempting to 
calibrate the detector. 

     2  
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Chapter 3  

The Run Dialog Box es  and Collecting Data  

 

3.1  SIN GLE RUN - 

The Single Run dialog box (Figure 3-1) is used to enter the various parameters for a single run. 

 

Figure 3-1: Single Run Dialog Box  
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The following fields should be entered: 

�x�� Path: Select the folder in which the data should be stored. The Browse button accesses a dialog 
box that is used to search for the desired folder or make a new folder in the selected directory 

�x�� File Name and File Extension: Indicate the file name and extension under which the raw data 
will be saved (e.g. beta.$01). 

�x�� File Type: Indicate the format that should be used to store the data.  

�ƒ�� The $ format will save data for the 15o, 90o, RI and UV detectors only in the Precision 
Detectors native format (e.g. beta.$01).  

�ƒ�� The # format is will save data for all detectors in the Precision Detectors native format (e.g. 
beta.#01). 

�ƒ�� The ASCII format is used for exporting the data to most external programs such as Microsoft 
Excel (e.g. beta.a01) in a comma delimited format. 

�x�� Operator, Eluent and Sample Name: Used for annotative purposes and are stored with the data 
file. 

�x�� dn/dc, UV Ext Coeff, Refractive Index and Temperature: Used to enter the relevant 
parameters for post run calculations.  

�x�� Run Length: Enter the desired period for data collection. 

�x�� Sample Interval: Indicate the frequency for which data points should be averaged. Each 
averaged data point will be stored in the data file. In most instances, 1 sec is satisfactory. If the 
run is very long (e.g. >45 min, a value of 2 sec can be used to reduce the number of data points. 

�x�� Prewait: Indicate if a time delay is desired between the onset of the run and the time when data is 
to be collected. 

�x�� Flow Rate, Concentration and Injection Volume: Enter the relevant parameters, which will be 
stored with the file. 

�x�� Laser Power: Used to set the maximum power for the laser (PD Expert only). 

�x�� Sample Info: Enter alphanumeric data for annotation purposes.  

�x�� Correlator : For the PD Expert, this field will include a series of radio buttons to indicate the 
active DLS channel and select the run time pf the correlator. 

�x�� Run Time: Period of time for the collection of data. 

�x�� Viscosity: Viscosity of the sample 

The Wait for AutoStart  check box is used to indicate if the run should be started by an external signal 
(i.e. a contact closure from the chromatograph). If this box is not checked, the run is initiated by pressing 
the OK button.  

When the run is initiated, the data will be presented on the main window as shown in Figure 3-2. 
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Figure 3-2:  Display of Data 

To stop a run, press Stop Run on the Acquire menu. 

If you right click in the plot, a menu with the following items will be presented. 

�x�� Zoom - Used to expand a region of the plot 

�x�� Unzoom - Returns a Zoomed plot to the standard plot.  

�x�� Grid Display - Presents a grid on the display for ease in reading the plot  

�x�� Legend �± Displays the Left and Right Y-Axis legends 

     3  
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3.2  MULTIPLE RUN  

 

3.3  ZIMM RUN  

The Zimm Run dialog box (Figure 3-2) is used to enter the various parameters for data collection to 
generate a Zimm plot. 

 

Figure 3-2:  Zimm Run Dialog Box - Calibration Run Type 

The following fields should be entered: 

�x�� Run Type: Indicate if this is a calibration or a sample. If you are running a sample, the dialog 
box will appear as shown in Figure 3-3. 
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Figure 3-3:  Zimm Run Dialog Box - Sample Run Type 

�x�� File Type: Indicate the format that should be used to store the data.  

�ƒ�� The $ format will save data for the 15o, 90o, RI and UV detectors only in the Precision 
Detectors native format (e.g. beta.$01).  

�ƒ�� The # format is will save data for all detectors in the Precision Detectors native format (e.g. 
beta.#01). 

�x�� The ASCII format is used for exporting the data to most external programs such as Microsoft 
Excel (e.g. beta.a01). 

�x�� Path: Select the folder in which the data should be stored. The Browse button accesses a dialog 
box that is used to search for the desired folder or make a new folder in the selected directory 

�x�� File Name and File Extension: Indicate the file name and extension under which the raw data 
will be saved (e.g. beta.01). 

�x�� Number of Concentrations: Indicate the number of samples that are to be run via the drop down 
menu. The appropriate number of Concentration fields will be activated for entry of the 
concentration of each sample. 

�x�� Temperature: Indicate the temperature that will be used for the measurement  

�x�� Collection Time: Enter the desired period for data collection. 

�x�� Laser Power: Indicate the fraction of full power for the laser. 
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�x�� Calibr ation Information : Enter the molecular weight and Second Virial Coefficient. If you do 
not know the Second Virial Coefficient, enter 0. 

�x�� Operator, Solvent, Refractive Index, dn/dc Sample Name: Enter each parameter. 

�x�� Sample Info: These fields are used to indicate additional information that will be included with 
the sample file. 

When the run is initiated, the data will be presented on the main window as shown in Figure 3-3. 

 

Figure 3-3:  Display of Data 

To stop a run, press Stop Run on the Acquire menu. 

If you right click in the plot, a menu with the following items will be presented. 

�x�� Zoom - Used to expand a region of the plot 

�x�� Unzoom - Returns a Zoomed plot to the standard plot.  

�x�� Grid Display - Presents a grid on the display for ease in reading the plot  

�x�� Legend - Displays the Left and Right Y-Axis legends 
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Appendix A  

Theory of Light Scattering  

 

8.1  OVERVIEW  

Light Scattering refers to the process in which light from an incident polarized laser beam is scattered in 
all directions when it interacts with a molecule or particle. Light scattering is an everyday occurrence and 
�Z�D�V���I�L�U�V�W���G�H�V�F�U�L�E�H�G���E�\���/�R�U�G���5�D�\�O�H�L�J�K���L�Q���W�K�H���O�D�W�H�����������¶�V�����$�Q���H�[�D�P�S�O�H���R�I���O�L�J�K�W���V�F�D�W�W�H�U�L�Q�J���L�V���W�K�H���V�F�D�W�W�H�U�L�Q�J���R�I��
sunlight by particles in the atmosphere: the sky is blue because shorter visible wavelength radiation (blue 
light) is scattered more strongly by the gas molecules in air than light of longer wavelengths (red light). 

There are two general techniques for the measurement of physical properties of polymers (synthetic 
polymers and natural polymers such as proteins and polysaccharides), virons, liposomes and particles. 

�x�� Static Light Scattering (also known as Rayleigh scattering or classical light scattering) - The 
intensity of the scattered light from the sample dissolved in the solvent. This difference between 
the two measurements can be used to determine the average molecular weight and Rg (radius of 
gyration). To complete the molecular weight determination, the concentration of the compound of 
interest is required (typically obtained from a refractive index detector or an absorbance detector). 
Static Light Scattering is described in Section A.3. 

�x�� Dynamic Light Scattering (also known as Quasi-elastic scattering, Photocorrelation 
Spectroscopy, or Beat Spectroscopy) - The fluctuations of the intensity of the scattered light is 
used to determine the diffusion coefficient of the molecules as they move in solution (Brownian 
motion). The Stokes-Einstein equation is used to determine Rh (the hydrodynamic radius of the 
molecule). Dynamic Light Scattering is described in Section A.4. 

Static and Dynamic measurements can be made on a sample in a cuvette or in a flowing stream such as 
that found in high performance liquid chromatography (HPLC), size exclusion chromatography (SEC) or 
gel permeation chromatography (GPC). In flowing streams, measurements are made on each elution slice 
using a unique light scattering design and very fast digital signal processors (which are essentially special 
purpose computers).  

This chapter describes the fundamentals of the theory of light scattering. A short list of references for 
additional reading is presented in Section A.4. 

     A  
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A.2  THE PHYSICAL BAS IS OF LIGHT SCATTERI NG  

Light consists of perpendicular electric and magnetic fields that oscillate in a direction that is 
perpendicular to the direction of propagation of the light as shown in Figure A-1. When light strikes a 
molecule, the electrons will experience a force due to the electric field and will move slightly. This 
movement will induce an oscillating dipole moment that will radiate light in all directions at the 
oscillating frequency. This radiated light is the scattered light that is detected and processed as described 
below. 

 
Figure A-1:  Light Scattered by a Molecule 

Figure A-1 describes the spatial arrangement of the incident light and scattered light in the light scattering 
experiment. The light is polarized in the vertical direction, thus the electric field will oscillate in the Z-
direction and the magnetic field will oscillate in the X direction.  

A diode laser, which is a monochromatic source of light that can be focused to a very small point in the 
center of the sample cell is used in PDI light scattering systems. Typical sources include a semiconductor 
laser that can provide 20 to 30 mW at 685 nm and another which provides 100 to 150 mW at 800 nm. The 
scattered light is collected at a given angle and orientation (e.g. 15o or 90o) from the incident radiation, 
and is used to deduce the desired molecular properties.  

A.3  STATIC LIGHT SCA TTERING  

A.3.1  Measuring the Molecu lar Weight  

Note: Since Precision Detector systems include polarized laser light sources, the equations presented in 
this chapter will be slightly different than those presented in discussions of light scattering when non-
polarized sources are used.  

The electric dipole moment that is induced is shown in equation A-1. 
�Æ          �Æ 

�S��� ���.���(��         A-1
  
 

where: p is the dipole moment 
 �. is the polarizability  
 E is the electric field 
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The polarizability can be related to measurable parameters via equation 8-2. 

�ù��� ���0w ���G�Q���G�F�������Œ�1A        A2 

where: Mw is the molecular weight 
  NA  is A�Y�R�J�D�G�U�R�¶�V���Q�X�P�E�H�U���������������[������23 molecules per mole) 

dn/dc is the change in the index of refraction as a function of the change in 
 concentration. It is considered to be a constant for any specified solvent-solute pair under 
 constant operating conditions. 

The oscillating dipole will radiate light in all directions at the oscillating frequency. This is the origin of 
scattered light. If a single molecule has dimensions that are small with respect to the wavelength of the 
incident light , the intensity of the light can be defined by equation A-3.  

I s � ���>�����Œ2 Mw sin2�-�����G�Q���G�F��2 Io]/NA
2 ��o

4 R2
     A-3 

where: I s is the intensity of the radiated light 
I o is the intensity of the incident light 
��o is the wavelength of light in a vacuum 
�-  and R are as defined in Figure 8-1 

If we collect light from a volume V of a solution with a concentration c (gm/mL), the intensity of 
scattered light can be found by multiplying equation 8-3 by the number of molecules in the volume V. 
The number of molecules can be expressed by NA c V/Mw. 

Now if we solve for Mw, we obtain equation A-4 

Mw = NA
2 ��o

4 R2 Is ���������Œ
2 Mw sin2���-���F�����G�Q���G�F��2 Io V    A-4 

Collecting all the constants and instrumental parameters into an overall instrumental constant, A, we 
obtain equation A-5. 

Mw = Is / A c (dn/dc)2 Io        A-5 

Equation 8-5 can be used to measure the molecular weight Mw of small molecules at any scattering angle 
�������,�W���V�K�R�X�O�G���E�H���Q�R�W�H�G�����K�R�Z�H�Y�H�U�����W�K�D�W���O�D�U�J�H�U���P�R�O�H�F�X�O�H�V���V�F�D�W�W�H�U���O�H�V�V���O�L�J�K�W���D�W���K�L�J�K���Y�D�O�X�H�V���R�I�������W�K�D�Q���D�W���O�R�Z��
angles because of interference effects caused by the fact that light scattered from one part of the molecule 
travels a different distance from another part of the molecule, and is not in phase with light scattered. This 
phenomenon can be quantified by defining the light scattering form factor (equation 8-6). A more detailed 
discussion of the form factor is presented in Section A.3.3. 

�3��������� ���V�F�D�W�W�H�U�H�G���L�Q�W�H�Q�V�L�W�\���D�W���D�Q�J�O�H�����������V�F�D�W�W�H�U�H�G���L�Q�W�H�Q�V�L�W�\���D�W���D�Q�J�O�H���-��  A-6 

�,�W���V�K�R�X�O�G���E�H���Q�R�W�H�G���W�K�D�W���3���������F�D�Q���E�H���Z�U�L�W�W�H�Q���D�V���D���V�H�U�L�H�V���D�V���V�K�R�Z�Q���L�Q���H�T�X�D�W�L�R�Q���$-7. 

�3��������� ������- 1/3( q 2 Rg
2) +          A-7 

where: q��� �������Œ���Q���V�L�Q����������������o 
R is the radius of gyration of the molecule 
n is the index of refraction of the liquid 
��o is the wavelength of light in a vacuum 

For scattering at 15o and 90o, equation 8-7 can be expressed as equations A-8 and A-9, respectively. 

�3��������� ����- 26.3 (Rg �Q������o)
2       A-8 

�3��������� ����- 0.0897 (Rg �Q������o)
2        A-9 

We present a table of P values for 15o and 90o degrees as a function of molecular weight (for molecules 
with molecular weight from 104  to 108 Daltons) in Table 8-1. These values assume that the molecules are 
random coils 

     A  



A-4  PrecisionAcquireUSB  �²  Appendix A  

Table A-1:  Value of P(90o) and P(15o�����I�R�U����o = 685 nm, n = 1.5 

Mw Rg (Approx) nm P(90o) P(15o) 
5 x 103 2.3 0.9993 1.0000 
5 x 104 7 0.9993 0.9998 
5 x 105 23 0.9993 0.9976 
5 x 106 70 *1 0.9780 
5 x 107 230 *1 0.7622 

*1 values depend on shape 

�,�I���W�K�H���Y�D�O�X�H���R�I���3������ found in equation A-7 is below 0.7, higher order components become important. In 
�W�K�L�V���F�D�V�H�����3���������G�H�S�H�Q�G�V���R�Q���5g and also on the shaper of the molecule as shown in Figure A-2. 

 
Figure A-2:  Values of p-1���������D�V���D���I�X�Q�F�W�L�R�Q���R�I���T2<Rg2> for various particle shapes: 1 = Sphere, 
   2 = Gaussian Coils, 3 = Rods. 

�,�W���L�V���F�O�H�D�U���W�K�D�W���D�O�O���W�K�U�H�H���P�R�O�H�F�X�O�D�U���V�K�D�S�H�V���\�L�H�O�G���W�K�H���V�D�P�H���Y�D�O�X�H���R�I���3���������Z�K�H�Q���T2 <Rg2>is less than 
�D�S�S�U�R�[�L�P�D�W�H�O�\���������$�V���W�K�H���Y�D�O�X�H���R�I���3���������L�Q�F�U�H�D�V�H�V�����W�K�H���V�K�D�S�H���R�I���W�K�H���P�R�O�H�F�X�O�H���F�O�H�D�U�O�\���L�Q�I�O�X�H�Q�F�H�V���W�K�H���O�L�J�K�W��
scattering intensity.  
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A.3.2  Using Refractive Index Measurements to Measure Concentration  

Refractive index measurements can be used in conjunction with static light scattering measurements to 
determine the concentration of the compound in the chromatographic slice.  

The difference in refractive index between the solution under study and the pure solvent is measured by 
passing a light beam thru two cells as shown in Figure 7-3. One of the cells contains pure solvent and the 
other contains the eluant as it passes thru the cell after the column. The cell with the pure solvent should 
be filled with the solvent prior to the separation and should be at the same temperature as the eluant. 

The observed signal (RI), which corresponds to the deviation of the light beam is proportional to the 
difference in the refractive index of the fluid in the two cells as shown in equation A-10  

RI = B (dn/dc) c        A-10 

where: B is an instrumental constant  
c is the concentration of the sample in the solvent 
dn/dc is the change in the index of refraction of the solution as a function of 

concentration. It is considered as a constant for any  specified solvent-solute pair under 
constant operating conditions 

A.3.3  The Form Factor  

The form factor at a particular angle is the ratio of the signal at that angle when compared to the signal 
expected at the theoretical angle of 0o (where there is not form factor) as indicated by equation 8-6. The 
importance of the form factor is that small molecules (e.g. those which have a radius that is < 10 nm, 
which is small when compared to the wavelength of the incident light) are studied, generate comparable 
signals at all angles, while large molecules generate signals that are smaller at higher angles and larger at 
small angles 

A.3.4  Characteristics o f Low -Angle (15 o) Light Scattering  

Low Angle light scattering data is collected at a 15 angle to the incident beam and is typically used for 
determination of the molecular weights of large molecules. This measurement angle is especially useful 
for the study of proteins with molecular weight of greater than 1,000,000 Daltons and for random coils 
with molecular weight between 200,000 Daltons and about 10,000,000 Daltons. 

In addition, 15o data is also used with 90o data to measure Rg, the radius of gyration of molecules over a 
limited range of sizes (12-150 nm) using static light scattering analysis.  

A.3.5  High Angle Light Scattering  

Low angle light scattering data is collected at a 90  angle to the incident beam and is typically used with 
static light scattering analysis to measure the molecular weight of smaller molecules such as proteins with 
a molecular weight below 1,000,000 Daltons, random coils with molecular weight below 200,000 Daltons 
and for lower molecular weight non-spherical coil polymers. In addition, it is used with dynamic light 
scattering analysis to measure Rh, the hydrodynamic radius of molecules and particles from 1 to 1,000 
nm. 

     A  
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Appendix B  

General Principl es of Dynamic Light Scattering  

 

B.1  WHAT IS LIGHT SC ATTERING?  

The propagation of light may be considered as a continuous rescattering of the incident electromagnetic 
wave from every point of the illuminated medium. The amplitude of each secondary wave is proportional 
to the polarizability at the point from which this wave originates; if the medium is uniform, rescattered 
waves will have the same amplitude and interfere destructively in all directions except in the direction of 
the incident beam. If, however, at some location the index of refraction differs from the average value, the 
wave that is rescattered at this location is not compensated for and some light will be observed in 
directions other than the direction of incidence and light scattering occurs. Scattering of light can be 
viewed as a result of microscopic heterogeneities within the illuminated volume; and macromolecules and 
supramolecular assemblies are examples of such heterogeneities. 

B.2  LIGHT SCATTERING  TECHNIQUES  

Static light scattering probes concentration, molecular weight, size, shape, orientation, and interactions 
among scattering particles by measuring the average intensity and polarization of the scattered light. 
Static light scattering measurements which are performed at different scattering angles provide 
information on the molecular weight, size, and shape of the scattering particles. Measurements of the 
intensity of light scattering as a function of concentration yield the second virial coefficient, which is the 
key characteristic of the strength of attractive or repulsive interactions between solute particles. 

Quasielastic (dynamic) light scattering1,2 probes the relatively slow fluctuations in concentration, shape, 
orientation and other particle characteristics by measuring the correlation function of the scattered light 
intensity. Fast vibrations of small chemical groups which lead to significant changes in the frequency of 
the scattered light is the domain of Raman spectroscopy. These latter two methods, which probe the 
dynamics of the particles which cause light scattering, are intrinsically more complicated than static light 
scattering, since they involve measurements of spectral characteristics or related correlation properties of 
the scattered light. 

     B  
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B.3  LIGHT SCATTERING  FROM  MACROMOLECULES IN S OLUTION  

One may consider the solution as a homogeneous medium and ascribe light scattering to the spatial 
fluctuations in the concentration of a solute. An alternative way is to consider each individual solute 
particle as a heterogeneity and therefore as a source of light scattering. The first approach is more 
appropriate for solutions of small molecules in which the average distance between the center of the 
scatterers is small compared to the wavelength of light. The second approach is more appropriate for 
solutions of large macromolecules and colloids, when the average distance between particle centers is 
comparable to the wavelength of light.  When the size of the solute particles becomes comparable to the 
wavelength of light, the description of the effects of orientational motion and deformation of the solute 
particles is much more straightforward when these particles are treated as individual scatterers.  

Intensity of the light scattered by a single particle is dependent on the mass and the shape of the particle. 
In this discussion, we will consider an aggregate composed of m  monomers and the amplitude of the 
electromagnetic wave scattered by an individual monomer is E0   (at the point of observation). If the size 
of the aggregate is small compared to the wavelength of light (�O), all waves scattered by individual 
monomers interfere constructively and the resulting wave has an amplitude E � mE0 . Since the intensity 
of a light wave is proportional to its amplitude squared, the intensity of the light scattered by the 
aggregate is proportional to the aggregation number squared, I � m2 I0 , where I0  is the intensity of 
scattering by a monomer. The quadratic dependency of scattering intensity on the mass of the scatterer is 
the basis for optical determination of the molecular weight of macromolecules. It is this dependency 
which is accounted for by the Mass Normalization function of PrecisionDeconvolve. 

If the size of an aggregate particle is not small compared to �O, the interference of the electromagnetic 
waves scattered by the constituent monomers is not all constructive and the phases of these waves must 
be taken into account. If the phase of a wave scattered at the origin is used as a reference, the phase of a 
wave scattered at a point with radius vector r  is q�xr  as shown in Figure B-1). The vector q  is called the 
�³�V�F�D�W�W�H�U�L�Q�J���Y�H�F�W�R�U�³�����Z�K�L�F�K���L�V���D���I�X�Q�G�D�P�H�Q�W�D�O���F�K�D�U�D�F�W�H�U�L�V�W�L�F���R�I���D�Q�\���V�F�D�W�W�H�U�L�Q�J���S�U�R�F�H�V�V�������7�K�H���O�H�Q�J�W�K���R�I��the 
vector is indicated in equation B-1. 

 
q �{ q � 

4�Sn
�O

sin�T 2
         B-1 

 
 where: n is the refractive index of the medium 

 �O is the wavelength of light 
  �T is the scattering angle 

Partial cancellation of waves scattered by different parts of the large aggregate reduces the intensity of 
light scattering by a factor of �D

��
, where �D is an averaged value of the phase factors     exp(iq�xr)  for all 

monomers. The factor �D should be averaged over all possible orientations of the particle. The result of 
this averaging yields the structure factor, S q�� ��. Expressions for the structure factors for particles of 
various shapes can be found elsewhere.3  
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Figure B-1:  The Scattering Vector q  

The path traveled by a wave scattered at the point with radius vector r  differs from the path passing 
through the reference point O by two segments, 1 and 2, with lengths l1  and l2 , respectively. The phase 

difference is �' �I � k l1 �� l2�� �� where k �{ k � k0 � 2�Sn �O is the absolute value of the wave vector k  

(or k0 ). The segment l1  is a projection of r  on the wave vector of the incident beam k0 , i.e. 

l1 � r �xk0 k . Similarly,     l2 � �� r �xk k , and thus �' �I � r �x k0 �� k�� ��� rq . Vector q � k0 �� k  is called 

the scattering vector. 

B.4  METHOD OF QUASIE LASTIC LIGHT SCATTER ING SPECTROSCOPY (QL S)  

B.4.1  The M otion of Particles in Solution  

When light is scattered from a collection of N solute molecules, at the observation point we also have a 
sum of waves scattered by individual particles (Figure B-1). Each particle could be at any random 
location within the scattering volume (the intersection of the illuminated volume and the volume from 
which the scattered light is collected). Since the size of the scattering volume is much bigger than q-1 
(with the exception of nearly forward scattering, where q ~ �T�| �� ), the phases of the waves scattered by 
different particles will vary dramatically. As a result, the average amplitude of the scattered wave is 
proportional to N  and the average intensity of the scattered light is simply N  times the intensity 
scattered by an individual particle, as expected. The local intensity, however, fluctuates from one point to 
another around its average value. The spatial pattern of these fluctuations in light intensity, called an 
�L�Q�W�H�U�I�H�U�H�Q�F�H���S�D�W�W�H�U�Q���R�U���³�V�S�H�F�N�O�H�V�´�����L�V���G�H�W�H�U�P�L�Q�H�G���E�\���W�K�H���S�R�V�L�W�L�R�Q�V���R�I���W�K�H���V�F�D�W�W�H�U�L�Q�J���S�D�U�W�L�F�O�H�V�����$�V���W�K�H��
scattering particles move, the interference pattern changes in time resulting in temporal fluctuations in the 
intensity of light detected at the observation point. The essence of the QLS technique is to measure the 
temporal correlations in the fluctuations in the scattered light intensity and to reconstruct from these data 
the physical characteristics of the scatterers. 
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